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WHAT WE LOOK FOR IN APPLICANTS

Competitive applicants embody the personal character traits and values essential to building the ties
and trust that define a strong community. Members build a community for the long-haul of their
professional lives. We look for people with honesty, integrity, humility, and a desire to serve others
before themselves. Strong applicants aspire to leadership in national security and global affairs by
leveraging their expertise in policy, politics, or hard security, whether in or out of government. We’re
looking for individuals who understand the importance of collaboration with others whose strengths
complement their own. Truman Members must be over the age of 21. There is no maximum age cap
for Truman membership. The age requirement is in place because Truman members are expected to
possess a certain level of relevant professional experience, but we implore younger individuals
interested in Truman to submit an application when they’re of legal age.

We look for individuals who believe in defense, diplomacy, development, and democracy. That can
be reflected through:

● Policy expertise in academia, government institutions, non-profits or law
● On-the-ground experience from military service, global health, or humanitarian work
● Hard security expertise from defense contracting, intelligence or operations
● Political expertise from campaigns, fundraising, elected office, or grassroots organizing
● Communications expertise from consulting, speechwriting, and working in the press

We also look for individuals who will uphold our Mission and Values:

The mission of the Truman National Security Project is to unite and equip a diverse community of
American leaders to produce timely, innovative, and principled solutions to complex national

security challenges.

The vision, in partnership with our sister organization, the Truman Center for National Policy, is an
inclusive foreign policy that makes American lives better by advancing democracy, human rights,

prosperity and security at home and abroad. Our work is guided and informed by our commitments
to:

1. Do work that matters. Be ambitious, tackle worthy problems, and have a theory of alignment with our

goals for national security, leadership, or both.

2. Protect the torch. Do your diligence, taking care to work only with people and  organizations we can

be proud of. Conduct your work as a professional, with the highest standards for content, form, and

delivery. Every Truman member is an Ambassador of this organization and its members.
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3. Protect the community. Look within the Truman community for help; it’s here. In return, help when

asked if you’re in a position to do so. Treat each other with respect.

4. Lift up and make room for others. Share the mic, be inclusive, and offer even strong opinions in a

way that will leave others comfortable sharing their own.

5. Assume and model good faith. Engage with the most generous interpretation of

others’ speaking and writing. Ask clarifying questions if any other interpretation seems

plausible. Think about an issue from the other person’s perspective before you write or

speak.

6. Set the standard for professionalism and principle. Be on your best behavior. Ask what the

community would be like if everyone comported themselves honorably. We are what our habits make us.

7. Live gratefully. Say thanks and give thanks. Let folks know when they did

something you appreciate

8. Elevate diverse voices. Truman National Security Project seeks to expand the diversity of Americans

contributing to every level of the U.S. national security and foreign policy community. We are dedicated

to advancing Diversity, Equity, Inclusion, and Justice (DEIJ) as a national security imperative. Truman

condemns white nationalism and white supremacy. Racism is a threat to the social fabric of the United

States and is an important national security issue that degrades American democracy and the vitality

and credibility of U.S. global leadership. Truman strives to be a diverse and inclusive organization in

our recruitment of fellows, members, and staff, and in elevating diverse voices in the work we do

together.
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WHO SHOULD APPLY?

You should consider applying for membership if you plan on pursuing a career that impacts national
security, and you:

● Are a principled professional committed to responsible, inclusive, smart, tough international policy
● Are eager for a united community of similar professionals who will help each other to build and

lead on national security
● Come armed with skills that will help the community to build and lead. These might include:

○ Participating in public service, from considering elected office yourself to working in
campaigns or advising candidates

○ Appearing in the media or engaging in public speaking
○ Teaching progressive candidates, activists, voters,  college students, or other

citizens to improve their ability to understand national security issues
○ Writing in ways that shape the engagement of non-foreign policy experts on national

security issues

The Truman National Security Project is a 501(C)(4) membership organization. The
membership program is a nonpartisan educational program that may receive 501(C)(3) funds,
but is run by a 501(C)(4) organization. Therefore, law clerks and judges may not apply to this
program.

APPLICANT ELIGIBILITY

Please check your eligibility before you apply. You must:

● Submit your completed application by the application deadline

● Be a U.S. citizen

● Live in one of the 16 chapters for at least the duration of one year from when you are accepted.  Those

chapters are: Atlanta, Boston, Chicago, Colorado (Denver), Florida, Los Angeles, Michigan, New

York City, North Carolina, Ohio, Philadelphia, San Diego, San Francisco, Seattle, Texas, Washington,

DC. If you don’t live in one of these areas, please refer to the FAQ section

● Attend the virtual interview, if selected

● If extended an invitation to membership, attend your program’s orientation and the annual Truman

Conference in May. This year, orientation will be held in-person in Washington, D.C. (tentative date

February 2023)
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● Please do not apply unless you know you can attend the full three-day orientation and conference. If

you cannot attend your program’s orientation or have concerns about cost, please refer to the FAQ

section

● Affirm the values of the Truman community (see Truman Values Statement in the FAQ section below

or on our website).

Truman members have many ways of engaging in the public square, some of them partisan. Truman itself is a

501(c)4 advocacy group. For either reason, some organizations may forbid you to participate in Truman. For

example, current judicial clerks may not join. On the other hand, we are not aware of any reason why Hatch

Act or Active Duty uniformed status would restrict first-year participation in Truman. Nonetheless, we ask

that all applicants certify that they are confident they would be able to participate in Truman, if selected. If

you have doubts, please reach out to ask or consider whether next year would be a better time.

Membership Cohorts

Cohort membership helps us to ensure that our incoming class includes the ranges of experience that

help us to effect change. It also signals to other members of the community where your primary expertise

lies. While there is not currently a way to switch Cohorts after joining, all members receive the same rights

and privileges regardless of the Cohort through which they join Truman.

Security Fellows are policy experts, academics and other thought leaders who anticipate and articulate new

global challenges and opportunities. Many work within the US national security apparatus and legislative

bodies, as well as the international community and an expansive network of nongovernmental and private

organizations.

Political Partners are political leaders, advocates, communicators, journalists, and aspiring or actively

serving public officials. Fluent in campaign management, media, journalism, organizing, and more, they

advance progressive principles and a shared liberal internationalist worldview at all levels of civil society.

Defense Council members include veterans and frontline civilians who have firsthand experience

implementing US foreign policy. They have wide-ranging expertise in hard security and an ongoing

professional interest in defense and intelligence operations as they continue to serve in government,

business, policy, and nonprofit ventures.
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FIRST YEAR REQUIREMENTS

Truman is more than a loose collection of individuals. We unite as a tight-knit community in order to more

effectively build and lead. To that end, we require all members to participate actively in their first year.

Please ensure that you can fulfill these requirements in your first year, if you become a member:

● Pay annual membership dues. Introductory dues are $350. After the first year, dues are $250.*

● Attend orientation for three days, held in person in Washington, D.C. (tentative date February

2023)

● Attend virtual membership training sessions throughout the year.

● Attend TruCon, Truman's annual three-day members conference in Washington, D.C. The cost for

previous years has been $250 for in-person attendance.

● Participate in the new members mentorship program that meets virtually once a month
● Participate regularly in chapter events in order to foster a strong and trusted community.

● As problem-solvers in a gratitude-powered organization, we ask new members to support

community efforts well and/or often enough to earn thanks from three staff or senior members.

Additional efforts in this regard may substitute for Chapter meeting attendance.

We work hard to ensure the ability to pay application and membership fees does not affect candidates' or

members' participation in Truman. Please contact membership@trumanproject.org about financing options.

APPLICATION COMPONENTS

APPLICATIONS OPEN - MONDAY, JULY 11TH, 2022

APPLICATIONS CLOSE - MONDAY, AUGUST 22ND, 2022 (12 midnight Pacific time)

VIRTUAL OPEN HOUSE I - TUESDAY, JULY 19TH, 2022 7:00pm EDT

VIRTUAL OPEN HOUSE II  - TUESDAY, AUGUST 9TH, 2022 6:00pm PST
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The questions on the following pages allow us an opportunity to learn more about you. You might find that

we ask a bit more than other programs. You'll also find that we try to go above and beyond to create an

exceptional community of leaders - and that starts with our attention to detail during the selection process. In

this application, you will be asked for:

● $50 application fee

● Basic demographic information (optional)

● Six essay questions (approx. 200 - 250 words each)

● Résumé/CV

● Biography (500 Word Max)

● Two letters of recommendation

● Optional military service records such as a DD 214 form (if applicable and available, sanitized for

personally identifiable information)

● Links to additional materials (media appearances, publications, Linkedin Page, personal website or

project page, etc.)

You will have the option to save and continue your application. Incomplete and/or late applications will not

be considered. You will receive a submission receipt by email for this application and your $50 application

fee.

Questions may be directed to membership@trumanproject.org.

Attachments

Applicants will be asked to submit six essay questions in approximately 200 to 250 words each, and to

upload your responses together with your application materials in a single doc, docx. or pdf file.

How to merge your materials in a single pdf file:

For Windows: Visit the Adobe website and use their merger tool directly on your browser. OR use a

reliable third-party merger application such as: PDF Merger & Splitter to merge your document.
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For Mac:

(1) Open a PDF in Preview.

(2) Choose View > Thumbnails to show page thumbnails in the sidebar.

(3) To indicate where to insert the other document, select a page thumbnail.

(4) Choose Edit > Insert > Page from File.

(5) From the file dialog, select the PDF that you want to add, then click Open.

(6) To save, choose File > Export as PDF. For more information, read here.

You can also use your computer’s “screenshot” or “screen capture” function, then upload the image saved
into a word or google document. You can then save the document “File>Save as a PDF”.

Deadline for Applications: Monday, August 22nd, 2022 at 12 midnight Pacific time

Questions may be directed to membership@trumanproject.org.
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9



Page 2 — First Year Membership Requirements

10



Page 3 — Confirmation of Membership Eligibility and Truman Values Statement

11



12



Page 4 — Membership Preferences, Information, and Attachments

13



14



15



16



2023 COHORT FREQUENTLY ASKED QUESTIONS

Q: May I apply if I do not live in a Chapter city or state?

A: Living in a chapter city or state is essential to the first year experience. While Truman operations are

largely virtual due to COVID-19, we organize both virtual and in-person programming.  You may apply

for membership if you will be able to fulfill the participation  requirements of Associate Year beginning

at the time of acceptance and orientation. The ability to attend regular chapter meetings allows first year

members to create relationships and develop strong ties to the Truman community. If you currently do

not live near a chapter but know that you will be moving to a chapter area before pandemic restrictions

ease, you may still apply this year.

Q: How long does the application take to complete?

A: Completion time will vary depending on how long it takes to acquire your letters of  recommendation

and complete your essays. Excluding letters, your Truman application can take between 2-5 hours. Take

your time with your application to submit thoughtful essays and robust letters of recommendation.

You will have the option to save and continue your application. Incomplete and/or late applications will

not be considered. In the application we request:

● Basic demographic information

● Two letters of recommendations with their contact information

● Resume

● Six essay questions

● Optional military service records DD-214 (if applicable)

● Links to additional materials (media appearances and publications)

Q: What if I am qualified to apply to multiple cohort categories?

A: Many applicants find that their strengths fit into more than one membership cohort. When deciding

to which cohort you will apply, consider the following:

● At a social gathering, what kind of people do you gravitate towards?
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● What kind of outlets regularly publish work that you find interesting?

● What unique perspective do you bring to solving national security and global affairs issues?

If your answers were most tactically focused with an eye towards operations and on-the-ground

experience, Defense Council sounds right for you. If you focus more on up-to-the-minute updates on

elections inside and outside the beltway and include several social media platforms, the Political

Partnership is up your alley. If you enjoy in-the-weeds analysis of policy and history along with

pragmatic and well researched points, then the Security Fellowship may be the way to go.

Whichever you choose, know that you may be considered for the others. Know, too, that all members,

regardless of cohort, attend the same Orientation and are accorded the same rights and privileges as

Truman members.

Q: What do I do if I can’t make my orientation date?

A: If you already know that your schedule will not allow you to attend orientation weekend, please wait

to apply until next year. Full attendance at the three-day orientation is required.

Q: If I am on active duty or in a Hatch or Super Hatch position, can I still apply?

A: The Truman National Security Project is a legal 501(c)(4) and membership dues are considered a

donation to a 501(c)(4). Active duty military, Hatch and Super Hatch individuals are welcome to apply,

however we recommend that individuals check with their organizations’ legal authority first.

Q: What should I know about membership fees?

A: Membership Dues are $350 during the associate year, and $250 in subsequent years. That fee

covers a three-day Orientation, workshops, onboarding resources, and a host of other forthcoming

features in addition to regular membership resources ranging from op-ed writing and support to access

to jobs, opportunities, community listservs, and events. We don’t want financial need to hold anyone

back from applying to the membership, and have payment plans and other resources available.

Contact membership@trumanproject.org with any concerns regarding dues.
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Q: What are Truman’s values?

A: Truman Values Statement

The mission of the Truman National Security Project is to unite and equip a diverse community of

American leaders to produce timely, innovative, and principled solutions to complex national security

challenges.

The vision, in partnership with our sister organization, the Truman Center for National Policy, is an

inclusive foreign policy that makes American lives better by advancing democracy, human rights,

prosperity and security at home and abroad.

Our work is guided and informed by our commitments to:

1. Do work that matters. Be ambitious, tackle worthy problems, and have a theory of alignment with our

goals for national security, leadership, or both.

2. Protect the torch. Do your diligence, taking care to work only with people and  organizations we can

be proud of. Conduct your work as a professional, with the highest standards for content, form, and

delivery. Every Truman member is an Ambassador of this organization and its members.

3. Protect the community. Look within the Truman community for help; it’s here. In return, help when

asked if you’re in a position to do so. Treat each other with respect.

4. Lift up and make room for others. Share the mic, be inclusive, and offer even strong opinions in a

way that will leave others comfortable sharing their own.

5. Assume and model good faith. Engage with the most generous interpretation of

others’ speaking and writing. Ask clarifying questions if any other interpretation seems

plausible. Think about an issue from the other person’s perspective before you write or

speak.
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6. Set the standard for professionalism and principle. Be on your best behavior. Ask what the

community would be like if everyone comported themselves honorably. We are what our habits make us.

7. Live gratefully. Say thanks and give thanks. Let folks know when they did

something you appreciate.

8. Elevate diverse voices. Truman National Security Project seeks to expand the diversity of Americans

contributing to every level of the U.S. national security and foreign policy community. We are dedicated

to advancing Diversity, Equity, Inclusion, and Justice (DEIJ) as a national security imperative. Truman

condemns white nationalism and white supremacy. Racism is a threat to the social fabric of the United

States and is an important national security issue that degrades American democracy and the vitality

and credibility of U.S. global leadership. Truman strives to be a diverse and inclusive organization in

our recruitment of fellows, members, and staff, and in elevating diverse voices in the work we do

together.

Q: I submitted my application and realized I have additional information I would like to

provide (new job, additional publications etc), What do I do?

A: You can still access your application until the deadline to make changes or additions. Incomplete,

late applications, or additional documents  will not be considered past the deadline. For any questions

- email membership@trumanproject.org.

Q: Am I a competitive applicant?

A: The Truman membership is a nationally competitive program that accepts between 100 - 150 total

new members a year (with no more than 50 per Cohort). We suggest that you reach out to your Chapter

Director to learn more about the Chapter you are applying to. Here are a few members from past

classes:
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Bryce Barros (Expert Group Leader, TruAsia)

Security Fellow, Class of 2020, Los Angeles Chapter

Bryce C. Barros, a 2012 graduate of Norwich University in Vermont, majored in

political science with a Chinese minor. He engaged in international diplomacy

as his campus’ cadet service exchange officer to the Republic of China Military

Academy in Kaohsiung, Taiwan, to train with the Taiwan Army.

Bryce graduated with a Master’s in International Affairs degree from Texas

A&M University. He has interned for Long Term Strategy Group and was a

graduate assistant for Dr. William Norris, researching Asia-Pacific defense issues. He is currently an analyst

at Kharon focused on Northeast Asia-related sanctions issues.

Won Palisoul

Defense Council, Class of 2012, New York Chapter

Won enlisted in the U.S. Navy in 2001 and served as a Gas Turbine Technician

(Electrical) aboard guided missile destroyers. She was forward deployed in the

Pacific region for Operation Enduring Freedom (OEF). Shortly after separating

from the military in 2009, she founded a small business that she ran for four

years.

In 2012, Won was named a Veteran Associate at the New York Stock Exchange. Later that year, she became a

Mission Continues Fellow, and served as a Local Chapter Coordinator at Student Veterans of America. She

was an Office Manager at a retirement fund with over $6 billion AUM, an Examiner at an SRO examining

Swap Dealers with OTC Derivatives activities exceeding the $8 billion material swaps exposure threshold,

and a Senior Compliance Officer at a hedge fund with $4 billion AUM. Currently, she is a Certified Fraud

Examiner (CFE) and an Associate Director in Investment Banking Compliance.
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Given her passion for helping veterans, she founded the Women Veterans and Families Network (WVFN).

Won is a Tri-State Coordinator for the DNC Veterans and Military Families Council, Sister on the Planet

Ambassador at OxFam America, an Alumni Advisory Council Member at Columbia University School of

Professional Studies (SPS), Chair of Veterans Roundtable at CFA Society New York (CFANY) and Co-Lead

of Women Veterans on Wall Street (wVOWS), a subcommittee of Veterans on Wall Street (VOWS). She

holds an M.A. in Information Technology Management from Webster University, and an M.S. in Nonprofit

Management from Columbia University SPS, where she is an Adjunct Associate Faculty Member. She

resides in Manhattan with her husband, who is also a U.S. Navy veteran, and two children.

Francisco Bencosme

Security Fellow, Class of 2019, Washington DC Chapter

Francisco Bencosme (@bencosmef) is a Senior Advisor in the East Asian and

Pacific Affairs Bureau at the Department of State serving as a Political Appointee

in the Biden/Harris Administration. Prior to joining the State Department he

joined Open Society Foundations in 2020 as the Senior Policy Advisor for Asia

and Latin America. Previously, he served as the Asia Pacific Advocacy Manager

at Amnesty International USA where he testified multiple times before Congress

and provided expert media commentary on multiple issues including East Asia,

Southeast Asia and South Asia human rights issues. In 2018, Francisco was named one of The Hill’s Top

2018 Lobbyists for their campaign on Myanmar Rohingya issues. Before joining AIUSA, he served as a

Professional Staff Member on the U.S. Senate Foreign Relations Committee for five years, where he assisted

Democratic Senators on issues related to East Asia/Pacific, South Asia, and State Department/USAID

oversight. Francisco also served as the President of the Congressional Hispanic Staff Association and as a

board member of the Foreign Affairs Congressional Staff Association. Francisco is also a Truman Security

Fellow, a Penn-Kemble Fellow, and an International Career Advancement Program alum. Francisco received

his Master of Science in Foreign Service from Georgetown University, a graduate certificate from the USAF

Air University, and his B.A. from Wake Forest University.
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Jessica Morse

Political Partner, Class of 2018, San Francisco Chapter

Jessica Morse is the Deputy Secretary for Forest Resources Management at the

California Natural Resources Agency. In her role, she is working to increase the

pace and scale of forest restoration and vegetation treatment to make

Californians wildfire resilient. Prior to joining Governor Newsom’s

administration, Jessica spent nearly ten years in National Security working for

the Defense Department, State Department and the US Agency for International

Development. Her assignments included a year and a half in Baghdad, Iraq, as well as tours in India,

Myanmar, and US Pacific Command. Throughout her career she designed and executed innovative strategies

across agencies and governments, including a strategy using renewable energy technology transfer as a

catalyst for US defense engagement with India. Morse holds a Masters of Public Affairs from Princeton

University and a Bachelor of Arts in economics from Principia College. In 2018, Morse ran for U.S.

Congress in California’s 4th Congressional District.

Bunmi Akinnusotu

Security Fellow, Class of 2019, Washington DC Chapter

Bunmi Akinnusotu is a foreign policy enthusiast and organizational management

leader. As the Deputy Director of the Rangel Fellowship at Howard University,

Bunmi builds the talent pipeline of foreign service officers and international

affairs leaders. Prior to Howard, Bunmi was the Chief of Staff at Young

Professionals in Foreign Policy which also amplifies the voices of rising global

policymakers. She was a political appointee in the Obama Administration where

she served as Special Assistant in the Office of Land and Emergency

Management at the US Environmental Protection Agency. There, she coordinated international and domestic

efforts to advance resource conservation and bring greater visibility to the social and economic benefits of

reducing negative environmental impacts. Bunmi’s international journey began at Search for Common

Ground in Timor-Leste and she later taught English in Puerto Plata, Dominican Republic. Prior to her career
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in foreign affairs, Bunmi was a non-profit fundraiser for the YWCA and United Way in Chicago. She’s also

an AmeriCorps Alum and a Penn Kemble Democracy Fellow.

Jason Cain (Former Chapter Director, North Carolina)

Defense Council, Class of 2012, North Carolina Chapter

Jason Cain is passionate about making government work for his clients. From

his fellow veterans, to state government, to private enterprise, Jason strives to

ensure government institutions improve the lives and opportunity for all

Americans. Jason previously served as the Director of Intergovernmental

Affairs at the U.S. Department of Veterans Affairs where he was the

Secretary’s strategic advisor for programs and legislation involving state,

local, tribal, insular, and international governments. He acted as primary

liaison with Governors, Mayors, and state and local officials. Prior to joining VA he spent two years as the

Director of Outreach at the Vietnam Veterans Memorial Fund, the organization that built and maintains the

Vietnam Veterans Memorial wall in Washington, DC. A ten-year Veteran of the United States Army he served

with the 82nd Airborne Division and the U.S. Special Operations Command. He participated in five combat

tours to both Iraq and Afghanistan. Jason studied U.S. government between deployments and through night

classes while a single parent on active military duty. He has a Masters Degree in Legislative Affairs from

George Washington University and a masters in Public Administration from Harvard Kennedy School of

Government.
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